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RioScan ScanSeekTM RF 
Thank you for purchasing RioScan ScanSeekTM RF!  ScanSeek RF is a breakthrough 
application that will allow you to connect your Pocket PC® handheld device to any ODBC 
(Open Database Connectivity) data source through your wireless network. ScanSeek 
RF provides real-time data access, allowing records to be added, deleted, and edited on 
the handheld with resulting changes immediately posted to your PC data source. 
 
ScanSeek RF is optimized for use in barcode enabled wireless data collection 
applications.  You can easily create portable data collection systems by linking 
ScanSeek RF to a Microsoft® Excel spreadsheet, a Microsoft® Access database, or a 
variety of other data sources.  You can even build a Pocket PC front-end to your existing 
legacy system or server database in minutes.   

What is RioScan ScanSeek RF? 
ScanSeek RF is an easy to use tool that allows you to rapidly build portable data 
collection applications based on nearly any data in your enterprise.  If you have data in 
an ODBC data source such as Microsoft® Excel, Microsoft® Access, ASCII text, Oracle®, 
Microsoft® SQL Server, or most other common formats, ScanSeek RF can assist you to 
build a data collection application based on that data.  Product features include: 
 

• Wireless data synchronization 

• Support for a wide variety of databases through ODBC 

• Relational support, even between different databases 

• Record timestamps 

• Default field values 

• Read-only and required fields 

• Support for common data types 

• “Wizard” based application generation 

• No programming necessary 

• New!  Signature capture 

• New!  Bitmap support 
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System Requirements  

• Handheld Requirements 
ScanSeek RF requires a Pocket PC® handheld running Windows CE® version 
3.0 or later. 

• Personal Computer Requirements 
ScanSeek RF requires a PC running the Microsoft® Windows® operating system 
(including Windows® 95, 98, ME, NT, 2000, XP). 

• Other Requirements 
Microsoft ActiveSync® 3.1 or higher must be installed and successfully running 
prior to installing ScanSeek RF. 

• Network Requirements 
Your Pocket PC handheld must be able to establish a TCP/IP network 
connection to the PC running the ScanSeek RF Server software. 
 

Before Installation 
Before installing ScanSeek RF, you must have successfully finished installing the 
Microsoft ActiveSync software included with your Pocket PC.  Follow the directions 
included with that software to install it onto your PC.  
 
After you have ActiveSync installed, synchronize the Pocket PC to your PC. 
 

Note: You must perform the ActiveSync function at least once prior to the 
installation of ScanSeek RF; otherwise, the installation procedure may 
fail. 

 
Verify that Microsoft ActiveSync 3.1 or higher is running on your PC.  When ActiveSync 
is running, you will see a circular icon on the taskbar with two arrows pointing in opposite 
directions.  When it is active (a device is connected) it will appear green.  When it is 
inactive, it will appear gray.   
 
ScanSeek RF relies on ActiveSync for installation purposes only.  Once ScanSeek RF 
is installed, ActiveSync is no longer required. 
 

Installation 
1. Start Windows.  If your computer requires a login, log into an account with 

Administrator privileges. 
 
2. Close all open applications. 
 
3. Insert the ScanSeek RF CD into the PC’s CD-ROM drive. 
 
4. If the installation program does not launch automatically, select Start>Run from the 

Windows taskbar.  If it does launch automatically proceed to Step 6. 
 
5. When the “Run” dialog box appears, type:  x:\setup, and then click OK.  
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              <<x represents the CD-ROM drive letter>> 
 
6. The InstallShield Wizard will appear with a welcome screen. 
 
7. Click on the Next> button to continue. 
 
8. Read the license agreement and, if you agree to the terms, click on the Yes button. 
 
9. The Setup Type screen will appear.  Choose the Typical option if you are installing 

ScanSeek RF on a Pocket PC device with an ARM processor, otherwise choose 
Custom and select the appropriate configuration for your device. 

 
10. Additional configuration information is available on our website, www.rioscan.com.  If 

you are unsure of the type of configuration/device you are running, please consult 
the Frequently Asked Questions (FAQ) for ScanSeek RF on our website. 

 
11. The Install Shield Wizard will then complete the installation of ScanSeek RF. 
 
12. An Installation Complete screen will be displayed.  Select the Finish button. 
 
13. Reboot your PC. 
 
 

After Installation 
Verify that the software has been installed correctly. To do this, click your Windows Start 
Menu, select Programs and then look for the RioScan>ScanSeek RF program group.   
 
Prior to using ScanSeek RF on your Pocket PC, you must have the ScanSeek RF 
Server running on your PC.  See Appendix B on how to install and run the RF server. 
 
Up to date troubleshooting information is available from the RioScan web site at 
www.rioscan.com. 
  

Registration 
 
 
  
 
 
RioScan Contact Information: 
 
Email: support@rioscan.com 
Web: http://www.rioscan.com 
 
 

http://www.rioscan.com/
http://www.rioscan.com/
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Getting Started 
 
This section will guide you through configuring and registering an ODBC data source for 
use with ScanSeek RF.  ODBC (Open Database Connectivity) is an open standard 
designed to support generic access to a wide variety of databases and database-like 
files.  Data Sources are system resources, designated by a Data Source Name, that 
applications (such as ScanSeek RF) use to send and receive data.  To support access 
to your database or spreadsheet through ScanSeek RF, you must first set up an ODBC 
data source that identifies the filename and type of database you are using. 
 

Setting up Open Database Connectivity (ODBC) 
ScanSeek RF connects to a data source (Microsoft® Excel spreadsheet, Microsoft® 
Access database, etc.) through Open Database Connectivity (ODBC). Setting up an 
ODBC connection to a data source in the Windows® operating system is performed 
through the ODBC Data Source Administrator. 
 
The location of the ODBC Data Source Administrator varies between versions of the 
Windows® operating system. Follow the instructions below for the operating system 
installed on your computer system. 
 
For Windows® 95/98/NT the ODBC icon is located in: 

Start>Control Panel>Settings. 
 
For Windows 2000 the ODBC icon is located in: 

Start>Settings>Control Panel>Administrative Tools.  
 
For Windows XP the ODBC icon is located in: 
 Start>Administrative Tools 
 
Double click on the ODBC Data Source icon to display the “ODBC Data Source 
Administrator” dialog box.  For Windows® 9x, be sure to choose ODBC32. 
 

Note: See the section of this manual on using the ScanSeek RF Data Exchange 
Configuration Wizard for an alternate method of accessing the ODBC Data Source 
Administrator.  

 
Here are two examples for configuring ODBC data sources correctly. 

Configuring an ODBC Data Source using Excel 
 
1. When the ODBC Data Source Administrator dialog box appears, select the System 

DSN tab.  
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2. Click on the Add… button to display the “Create New Data Source” dialog box.  

 

 
 
3. Select the Microsoft Excel Driver (*.xls) and click Finish. 
 
4. The “ODBC Microsoft Excel Setup” dialog box will appear. 
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5. Enter the Data Source Name and Description into the appropriate fields.  The Data 

Source Name can be any meaningful name.  Click the Select Workbook… button. 
 
6. After clicking on the Select Workbook button, the “Select Workbook” dialog box will 

appear. 
 

 
 
7. Select the desired Excel File. Uncheck the ”Read Only” checkbox if you will be 

uploading changes from the handheld back to the spreadsheet. Then, click the OK 
button. 

 
8. Click the Options>> button. The “ODBC Microsoft Excel Setup” dialog box will 

expand to reveal the “Read Only” checkbox.  Be sure to uncheck the “Read Only” 
checkbox if you want to upload changes you make on the handheld.  If you 
unchecked the “Read Only” checkbox in Step 7, it should already be set correctly.  
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9. Click on the OK button in the “ODBC Microsoft Excel Setup” dialog box. 
 
 

 
 
10. In the “ODBC Data Source Administrator” dialog box, you should now see the new 

System DSN listed in the “System Data Sources” table.   
 

Configuring an ODBC Data Source using Access 
 
1. When the ODBC Data Source Administrator dialog box appears, select the System 

DSN tab.  
 
2. Click on the Add… button to display the “Create New Data Source” dialog box. 
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3. Select the Microsoft Access Driver (*.mdb) and click Finish. 
 
4. The “ODBC Microsoft Access Setup” dialog box will appear. 
 
 

 
 
5. Enter the Data Source Name and Description into the appropriate fields.  The Data 

Source Name can be any meaningful name.  Click the Select… button in the 
Database area. 

 
6. After clicking on the Select… button, the “Select Database” dialog box will appear. 
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7. Browse to and select the database file that contains your data, and then click on the 

OK button. 
 
 

 
8. Click on the “Read Only” selection to select or deselect that option depending on the 

type of database you are using. 
 
9. Click on the OK button in the “ODBC Microsoft Access Setup” dialog box.   
 
10. In the “ODBC Data Source Administrator” dialog box, you should now see the new 

System DSN listed in the “System Data Sources” table.   
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11. Click on the OK button to close the dialog box and return to the desktop. 
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Configuring ScanSeek RF  
 
ScanSeek RF can be configured to support one or more Applications.  Each Application, 
in turn, consists of one or more Data Exchanges.  Applications and Data Exchanges 
work together to customize your data collection process.  The first step in building a 
ScanSeek RF Application is setting up one or more Data Exchanges to connect 
ScanSeek RF to your data. 
 
To begin setting up and configuring a ScanSeek RF Data Exchange, go to 
Programs>RioScan>ScanSeek RF>ScanSeek from the Windows Start Menu. 
 

Planning Data Exchanges 
Each set of data that you work with in ScanSeek RF, along with it’s associated 
configuration information, is known as a Data Exchange.  A Data Exchange acts as a 
description of the type and manner in which data will be collected.  Before configuring a 
Data Exchange you should think through the following questions.  Doing so will help you 
work with the ScanSeek RF Data Exchange Configuration Wizard to choose the correct 
options for your application. 
 

• Will every data record consist of a unique identifier or barcode along with some 
associated information?  Example: Each record describes a piece of equipment 
identified by a unique serial number.  There will never be two records with the 
same serial number. 

• Alternatively, will most records be duplicates of template records with minor 
changes between records?  Example: Each record describes a maintenance task 
performed on a piece of equipment.  In this case, the equipment serial number 
may appear in many records, although each record may have a different 
timestamp or work detail. 

• Are some fields in your records limited to a specific set of values?  Are these 
values enumerated in a database table or spreadsheet named range?  Example: 
A field in your record indicates the Model Number of a piece of equipment.  You 
would like all known Model Numbers to appear in a drop-down list on the 
handheld rather than have to re-enter them by hand for each record. 

• If you are downloading information from an existing data source, do you want to 
limit the download to a subset of the fields in a particular table or named range?  
Example:  Your database records include accounting information that will never 
be entered on the handheld.  You want to download all the fields except those 
related to accounting functions. 

• Are you modifying or copying data from records for which one or more fields 
should not be changed?  Example: You are scanning participants entering an 
exhibition hall.  When you scan a badge, you want to verify participant 
information and record the date and time of the scan.  You don’t want to change 
any information except the date/time. 

• Are one or more fields in your application required?  Example: You are taking 
inventory and want to make sure that a current location is entered for every item 
scanned. 

• Will the application be used as part of a work process in which data changes 
rarely between scans?  Example: You are taking inventory and want to retain the 
last item number and location between scans until you manually change them. 
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• Is your download data source the same as your upload data source?  Example: 
You are downloading an initial inventory list from one table in your database but 
are uploading all collected data into a separate “changes” table. 

• If your application consists of more than one Data Exchange which Data 
Exchange will you work with most of the time?  Example:  Your application 
consists of Data Exchanges describing inventory items, locations, and inventory 
scans.  The scan Data Exchange will be the Data Exchange you work from, while 
the item and location Data Exchanges serve as lookup tables. 

 
Configuring a Data Exchange  
 
In order for your ScanSeek RF application to work with your handheld device, you must 
set up one or more ScanSeek RF Data Exchanges. Start the ScanSeek Application 
Designer by choosing Programs>RioScan>ScanSeek RF>ScanSeek from the 
Windows Start menu. 
 
In the Application Designer dialog box, right click on a blank area of the screen.  Select 
Data Exchange from the “New” menu. 
 

 
 
The “Add Data Exchange” dialog box will appear.  
 

 
 
Use the “Application Name” drop down menu to choose an Application.  (If you have not 
yet added an Application you may use “Default” and add the Data Exchange to an 
Application later.) Enter the name for the new Data Exchange. (You can choose any 
meaningful name for the Data Exchange.) Click on the OK button. 
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The ScanSeek Data Exchange Wizard will appear. Follow the Wizard’s on-screen 
instructions to complete the configuration of the new Data Exchange.   
 

 
 
The Wizard will ask you to choose the ODBC data source where the target data will be 
stored.  A drop down menu will list the names of properly configured ODBC data sources 
(System DSNs).   If you have not yet configured a data source, choose the <new> option 
to bring up the ODBC Data Source Administrator.  See the section on Setting Up Open 
Database Connectivity (ODBC) for more information. 
 

Note: The data source may require a User ID and Password, if this is the case, you 
may enter that information into the appropriate fields in this dialog box. (Contact your 
System Administrator for assistance if you do not know the User ID and Password).  

 
When all information has been entered correctly, click on the Next> button. 
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The Wizard will prompt you to enter either the name of a range (if you are using a 
spreadsheet) or the name of a table or query (if you are using a database). Use the drop 
down menu to specify the range/table to be accessed. 
 
Next, specify the field to be used from the data source as a search field using the 
second drop down menu.   
 

 
 
In choosing your search field, keep in mind that this is the field ScanSeek RF will use to 
scan, search, and identify individual records.  In many cases, the search field will 
correspond to the unique record identifier (or primary key) for your database table.  It will 
probably be the first barcode scanned in most barcode scanning applications. 

 
Under the search field selection, the ScanSeek Data Exchange Wizard has two options 
that allow you to customize the application’s behavior.   
 
This Data Exchange is read-only.  The first option allows you to specify that the Data 
Exchange contains read-only data.  If this option is checked, records cannot be added, 
modified, or deleted from the Data Exchange in the handheld application. 
 
This Data Exchange is a lookup table.  The second option allows you to specify that the 
Data Exchange can be used as a lookup, or cross-reference table for other Data 
Exchanges.  See the section on Data Exchanges as Lookup Tables for more 
information. 
 
On the lower right corner of the Wizard you will also see a button labeled Advanced…  
Clicking this button takes you to the Advanced Properties screen where you can specify 
individual attributes for each of the fields in your range or table.  See the section on 
Advanced Field Settings for more information. 
 
After clicking on the Next> button, the Wizard allows you to customize the way 
ScanSeek RF collects data and posts changes to your data source.  See the section 
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titled “Planning Data Exchanges” for examples of various factors involved in choosing 
these options. 
 

Note: If you checked the “lookup table” option in the previous step, you will 
configure your lookup table options before proceeding to this screen. 

 

 
Only allow one record per search field.  Choose this option if your search field uniquely 
identifies a record and no two records will share the same search field value.   
 
All changes result in new records.  Choose this option if your downloaded records are 
templates and you want all new records to be modified copies of existing records.  In this 
case, the search field will not be unique. 
 
Use a separate data source for upload.  Choose this option if you want to upload 
changes to a different table, range, or even different ODBC Data Source from your 
download.  See the section titled “Separate Output Option” for more information. 
 
Allow handheld users to delete records.  Choose this option if handheld users will be 
allowed to delete records.  This option may not be used with a separate upload data 
source. 
 
If you have chosen to use a separate data source for uploading data, you will be led 
through two additional screens that allow you to select an ODBC Data Source and 
table/range for upload.  The ODBC Data Source and table chosen can be completely 
different from those chosen for download.  You will not be asked to identify a separate 
search field.  Once you are done configuring these options, click on the Next> button to 
continue. 
 
The Wizard will display a summary screen that shows an overview of the Data Exchange 
configuration.  Verify all of the information to make sure that the Data Exchange is 
configured properly. Should you need to make corrections, click on the Back button.  If 
everything is correct, click on the Finish button. 
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The Data Exchange Wizard will attempt to validate your new Data Exchange 
configuration by verifying that all necessary attributes (e.g., ODBC Data Source, search 
field) have been assigned and all field options are valid.  If the wizard finds any errors, 
an error box will be displayed and any Application that include the Data Exchange will be 
marked as Inactive. 

 
 
When possible, an additional message window will be displayed describing any errors 
found in more detail.  
 

Data Exchanges as Lookup Tables 
Lookup tables provide a method to associate the records from one Data Exchange as a 
list of options for a field in another Data Exchange.  In database terms, lookup tables 
create a relationship between two tables.  For example, you may use one Data 
Exchange to represent all possible inventory locations in your building.  A second Data 
Exchange may represent actual inventory records including a SKU, a location, and a 
count of items in that location.  Using the first Data Exchange as a lookup table for the 
location field in the second Data Exchange will allow you to limit those records to hold 
only valid locations.  In addition, ScanSeek RF will provide a list on the Pocket PC for 
choosing the valid locations, eliminating data entry errors.  
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Note:  If you are using lookup tables, they must be configured before any data 
exchanges that link to the lookup tables. 

 
The steps below will guide you through the setup of a Data Exchange as a lookup table. 
 
After configuring your download table and search field in the Data Exchange Wizard, 
click on the checkbox that reads “The data exchange is a lookup table”.  Click on the 
Next> button. 
 
 

     
 
 

The Wizard will prompt you to choose a cross-reference field and a display field.  The 
cross-reference field, also referred to in ScanSeek RF as a Lookup ID, represents the 
actual value that will be placed in a Data Exchange field.  The display field, also referred 
to in ScanSeek RF as a Lookup Display, is often a more descriptive field that a user can 
recognize when viewing the data on the handheld.  Although the Lookup Display value 
will appear on the screen when viewing a data record, the Lookup ID value will be stored 
in the data field. 
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As an example, a typical database of parts will include an SKU or Part ID (such as 
#PPC-3345), along with a text description of the part (such as ¾" wingnut).  Your 
ordering system uses the SKU to identify all orders, but your field personnel using the 
handheld don’t have all of the SKU numbers memorized.  In this case, the SKU would be 
the Lookup ID, and the text description would be the Lookup Display. 

 
Note: Whenever possible, your Lookup ID should be the same as your Data 
Exchange search field.  Not doing so can cause considerable slow-down in the 
handheld application, particularly with large lookup tables. 
   

When you are done, click the Next> button and proceed to step 8 in the section titled 
“Configuring a Data Exchange”. 
 

Separate Output Option 
There are many reasons to use a separate data source for upload.  In some cases, 
information policies of your organization may require that the original data sources must 
not be tainted by new data from external sources.  In other cases, the download data 
source contains a set of pristine “templates”, or records that are copied as the starting 
point for new data.  In such cases, you will often want to upload data to a separate 
spreadsheet, database, or file that only contains newly collected data. 
 
By configuring a separate output, ScanSeek RF will write all changes to a different 
(upload) data source. That upload data source and corresponding range/table must 
match the download range/table closely.  The target (upload) table must use field names 
that correspond exactly with the download table field names.  In addition, the data types 
(text, numeric, date/time, etc.) for each field must match. 
 
The actual implementation of the upload data source can be very different.  For instance, 
it is possible to download data from a relational database (such as Microsoft® Access) 
and upload data back to a spreadsheet (such as Microsoft® Excel).  Again, the only 
requirement is that the upload and download data sources must have matching field 
names and field types. 
 

Advanced Field Settings    
In addition to supporting customization of a Data Exchange as a whole, each field in an 
included table or range can be customized separately.  The steps below will guide you 
through each of the settings and their use. 
 
After configuring your download table and search field in the Data Exchange Wizard, 
click on the Advanced… button. 
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The Wizard will display a screen that shows a list of all fields in the download table, a 
number of checkboxes representing attributes that can be set for each field, and a pull-
down selection indicating the lookup table (if any) associated with a field.  By default, 
ScanSeek RF marks every field as Included in the Data Exchange, and leaves all other 
attributes empty.  To modify the attributes of a particular field, begin by clicking on the 
field in the list box. 
 

 
 
To indicate that a particular field should not be included in the Data Exchange, and 
therefore will not appear on the handheld, uncheck the “Include this field in the Data 
Exchange” checkbox.  The search field for the Data Exchange must be included.  
Attempting to uncheck the Included box for the search field will result in the following 
error message. 
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To indicate that a field is required, check the “Required” checkbox.  Notice that the 
“Read-only” checkbox is unavailable for required fields.  When editing a record on the 
handheld, required fields must be filled in before saving. 
 
To indicate that a field is read-only, check the “Read-only” checkbox.  Notice that the 
“Required” checkbox is unavailable for read-only fields.  When editing a record on the 
handheld, you will not be able to modify read-only fields regardless of the read-only 
status of the Data Exchange.  This option is particularly useful when using the “All 
changes result in new records” option for the Data Exchange.  In this case, you may 
include necessary information in each record without allowing the handheld user to 
change the “template” part of the record. 
 
When performing repetitive data collection tasks, there is often only a small amount of 
information that changes between records.  For instance, while performing inventory you 
may be collecting data for hundreds of items that share the same location and count.  To 
keep from having to re-enter the same data for each record, you can choose the “Default 
to last value” option.  When this option is selected, the designated field will retain its 
value from record to record.  The carried over value will remain the same until manually 
changed by the handheld user.  Once changed, the new value will again be carried over 
between records, and so on. 
 
By default, the current date and time will be used for every date/time field whenever a 
user adds a new record on the handheld.  This is not the behavior, however, when 
copying an existing record.  By default, the value of the original record is copied along 
with the rest of the data when copying.  In cases where the copied record represents a 
template record, and an included date/time field represents a timestamp for the newly 
created record, check the “Default to current time” option for the timestamp field. 
 

Note: The “Default to current time” option will only change the behavior of 
ScanSeek RF when copying existing records.  New (blank) records always 
default date/time fields to the current date time regardless of this option. 

 
Fields capable of containing binary data (BLOB, OLE)  may be designated as Signature 
Fields by checking the Signature Field box. 
 
To designate a lookup table associate with a field, choose the Data Exchange that 
contains the lookup values from the drop-down list box under “Lookup values from 
another Data Exchange”. 
 

Note: Only existing Data Exchanges that have been designated as lookup tables 
are available in the lookup table list box.  It is good practice to configure lookup 
table Data Exchanges before configuring the Data Exchanges that use them. 
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The Lookup ID field associated with the selected lookup table Data Exchange must have 
the same type (text, number, date/time, etc.) as the field you are configuring.  If the field 
types do not match, you will see the following error. 

 
 
 
See the section titled “Data Exchanges as Lookup Tables” for more information on 
creating lookup table Data Exchanges. 
 
In addition to allowing you to include and exclude individual fields, ScanSeek RF also 
supports re-ordering the fields as they appear on the handheld.  Fields will appear on the 
handheld in the same order that they appear in the field list on the form.  To move a field 
up in the list, highlight the field and click the + button next to the field list.  To move a 
field down in the list, highlight the field and click the – button next to the field list.  The 
picture below shows the field list after the Date field has been moved up. 
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When you have finished configuring each field in your Data Exchange, click on the Done 
button. 

Working with the Application Designer 
 
An Application is a convenient way to group Data Exchanges that will be used together.   
 
A list of all active Applications will show on the Pocket PC when you first connect to a 
server.  You must have at least one active Application to use ScanSeek RF on the 
Pocket PC. 
 
When “ScanSeek” is started from the Windows Start Menu the ScanSeek Application 
Designer dialog box will appear.  The Application Designer dialog box is a diagram of 
Applications and Data Exchanges that have been configured to work with ScanSeek RF.  
Applications are designated by the  icon.  Data Exchanges are listed below the 
Applications and are designated by the  icon.   
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To create an Application, right click in the blank area of the screen.   
 

Click on Application.  You will see the following window. 
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Enter a name for your Application and click OK.  Your new Application will be added to 
the Application Designer screen.  The new Application will be added to the bottom of 
your list. 
 
If you want to change settings within an Application, right click the Application and you 
will see the following menu. 

 
You can create a New Data Exchange, Rename the Application, Delete it, Add a Data 
Exchange to your Application and Activate or Deactivate your Application from this 
menu. 
 
If your Application is not active and you want to Activate it, the Application Designer will 
check to make sure any necessary Lookup Data Exchanges are included in the 
Application.  If you have forgotten to add a Lookup Data Exchange to your Application, 
you will see an error message similar to the following. 
 

 
 
Once you have a Data Exchange configured, you can right click on it and bring up a 
menu of options as shown below. 
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You can Rename your Data Exchange, Delete it, Remove if from your Application, 
Configure it (if you need to re-configure) and Set it as the default Data Exchange.  Select 
your choice by tapping on it. 
 

Import/Export 
 
ScanSeek RF configurations can be saved to a file for backup purposes and for sharing 
between server installations.  To Import or Export your Application and Data Exchange 
configurations, click on File and choose the appropriate option. 
 

 
 

Note:  Before importing, make sure that you have all necessary ODBC DSNs set 
up properly.  You will not be able to activate your Applications until you do so.
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Working with ScanSeek RF on the Pocket PC 
 
When you turn on your Pocket PC you will see a screen similar to the one below. 
 
 

 
 
 
Tap Start on the upper left of the screen.  This will drop down the Start Menu, shown 
below.  Start the application on the device by tapping the ScanSeek RF icon once. 
 

 
 
This will bring up the “RF Server Properties” screen. 
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Tap on the down arrow at the right side of the input area below “ScanSeek RF Server:”.  
This will list any servers that you have connected to in the past.   
 

 
 
 
If your server name or IP address shows in the pull down list, select it.  If your server is 
not listed or the list is empty, enter your server information manually1.  This can be either 
the network name or IP address.  To automatically connect to the RF server, check the 
box below the “Connect” button that says “Auto-connect on startup.” 
 
When you tap the Connect button, ScanSeek RF will display the “Choose an 
Application” screen.  A list of all active Applications on the connected server will appear 
in the list.   
 

                                                
1 There are several ways to enter data on your Pocket PC.  You can use the “virtual keyboard”, 
the “numeric keypad”, and the “character recognizer”.  Please refer to your Pocket PC manual to 
learn how to use these functions.  In this manual, we will refer to the group of them as only the 
“virtual keyboard”.  Use whichever function suits either you or the situation. 
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Choose the Application you want to work with by tapping its name. 
 
ScanSeek RF will display the “Choose a Data Exchange” screen.  Only Data Exchanges 
that are included in the selected Application will appear in the list. 
 

 
 
 
To begin working with a Data Exchange tap its name.  When you choose a Data 
Exchange, you will be brought to the Record List screen.   
 

Note:  If you need to return to the Choose an Application screen, tap the  icon 
at the lower right of the screen. 

 
The following diagram will aid you in navigating through the ScanSeek RF Pocket PC 
interface. 
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Record List Screen 
 
 

A

F

B C D

E

L G H I J K
 

 
 
A. Record List:  The first column contains the search field of the Data Exchange.  The 

second column contains the first field of the Data Exchange.  To change the field 
order see the Advanced section of the ScanSeek Configuration Wizard. 

B. Input area:  Use this field to manually enter data to add or search. 
C. Action button:  Used for adding new records.  (See the section on Adding New 

Records.) 
D. Seek button:  Used for the search function (See the section on Searching for a 

Record). 
E. Navigation buttons:  Allow you to navigate through the records by going to the first 

record (First), the last record (Last)or moving through the records one page at a time, 
up (PgUp) or down (PgDn). 

F. You can resize your columns to make them wider or narrower by placing your stylus 
on the bar in-between your column headings and dragging it left or right. 

G. Network icon:  When tapped, it will take you back to the “RF Server Properties” 
Screen where you can change servers.   

H. Data Exchange icon:  Tapping on this icon will take you to the Select Data Exchange 
screen. 
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I. Refresh icon:  Tapping on this icon will force ScanSeek RF  to reconnect to the 
server and re-query the data source.  If you lose your RF connection, tap this icon to 
reconnect.  

J. About icon:  If you need to know the version of ScanSeek RF you are currently 
using, tap this icon.  

K. Virtual Keyboard.  Access the Virtual Keyboard by tapping here. 
L. File menu:  Tap to see two options:  Exit and Preferences.  Tap Exit to leave the 

program.  Tap Preferences to access program preferences (see the Section on 
Handheld Program Preferences). 

 

Searching for a Record 
ScanSeek RF provides a fast way to search for records in your Data Exchange.  To find 
a record, begin writing the first few letters or numbers of the search field into the Seek 
area. Then, tap the  icon and ScanSeek RF will move to the closest match.  
Alternatively, you may write in the entire search field value and tap the   icon. 
 

Once you see the record you are looking for on the screen, tap on the record to view it in 
more detail. 
 

Adding a New Record 
To add a new record, enter your data into the Seek: input box with the “virtual keyboard”.  
Tap the  icon when you have entered the search value of the new record.  ScanSeek 
RF will prompt you to confirm the creation of a new record.  Tap Yes to continue. 
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ScanSeek RF will construct and display the new record. You will notice that many of the 
fields will have no data. You will now be in Edit mode.  When you are finished entering 
your new information, tap OK to return to the main screen. 
 

Copying a Record 
If your Data Exchange was not configured with the “Only allow one record per search 
field” option, the detail view screen will include a button labeled “Copy”.  To copy the 
record and begin editing, tap on the “Copy” button.   
 

 
 

Editing a Record 
To edit a record, you must either Add a new record, Copy an existing record, or choose 
the Edit button from the View Record Screen.  The Edit screen displays the name of 
each field in the Data Exchange followed by the field data.  Longer field names may be 
truncated.  To edit a particular field tap on the field name or its value.  
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The manner in which you edit a field depends upon the field’s type, which is 
automatically determined by ScanSeek RF.  ScanSeek RF supports six different field 
types: Text, Integer, Floating Point, Boolean, Date/Time, and Bitmap.   
 
To edit a record, tap on the field name or value that you want to edit.   
 

Editing a Text Field 
To edit a text field, tap on the field name.  You will be taken to a screen similar to the 
one below. Highlight the text you want to change with your stylus. 
 

 
 
Enter your text and tap OK, to return to the Edit Record screen. 
 

Editing an Integer Field 
To edit an integer (whole number) field, tap on the field name.  You will be taken to a 
screen similar to the one below. Highlight the number you want to change with your 
stylus. 
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Enter your number and tap OK to return to the Edit Record screen. 

Editing a Floating Point Field 
To edit a floating point field, tap on the field name.  You will be taken to a screen similar 
to the one below. Highlight the text you want to change with your stylus. 
 

 
Enter your number and tap OK to return to the Edit Record screen. 

Editing a Boolean Field 
To edit a Boolean (True/False) field, tap on the field name.  You will be taken to a screen 
similar to the one below.  Choose TRUE or FALSE from the pull down list or tap “Clear” 
to enter a null value. 
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Editing a Date/Time Field 
To edit a Date/Time field, tap on the field name  You will be taken to a screen similar to 
the one below. 

 

 
 
If you tap the “Now” button, the date and time will updated to the current date and time. 
Both the Date and Time controls have a check box indicating whether the control is “in 
use”.  If either of the check boxes is unchecked, a null value will be entered for the date 
and time.  You can uncheck both boxes at the same time by tapping the “Clear” button.  
This will also produce a null value for the date and time. 
 
If you tap the down arrow to the right of the date, a calendar will pull down. 
 

 
 
You may choose a day in the current month and year or you may tap the arrows on 
either side of the month/year to move forward or backwards one month at a time. 
 
To change the time you can highlight the hour, minute, or seconds and tap the up and 
down arrows.  
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Editing a Bitmap Field 
Bitmap fields allow users to display Device Independent Bitmap data stored in a 
database.  Certain devices that support image capture can save bitmaps back to the 
database.  If the bitmap field is designated as a signature field, users can capture and 
display signatures with each data record.  Signatures may not be edited.  Once 
captured, they are always read-only. 
 

Editing a Lookup Field 
When you tap on a field that is associated with a Lookup Data Exchange the following 
screen will appear. 
 

 
You can select an item from a list by tapping on it.   
 
If your Lookup Data Exchange is not read-only, you will be able to add new items by 
tapping the bar at the bottom of the screen labeled “New Lookup Value”.  If you choose 
“New Lookup Value” you will be able to add a new record to the Lookup Data Exchange. 
 

CrossLinking 
 
A new feature of ScanSeek RF is the ability to work in a Lookup Data Exchange and link 
back to a Master Data Exchange.  Through CrossLinking you can add a new record to 
the Master Data Exchange and automatically associate it to the Lookup Data Exchange 
record you are reviewing.   
 
When you edit a record in the Lookup Data Exchange, you will see this icon  in the 
lower right of the screen.  Tapping on the icon will take you to a screen similar to the one 
below. 
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Select the Data Exchange you want add a record to.  When you are finished adding a 
record, tap OK and you will be returned to the Lookup Data Exchange. 
 

Delete a Record 
To delete a record, begin by selecting the record from the Record List  screen.  If 
deleting records is allowed within the Data Exchange, you will see the “Delete” button. 
 
 

 
Tap on “Delete”.  The following confirmation box will appear. 
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Tap Yes to delete the record.  Once you have deleted the record, you will be returned to 
the Record List screen. 
 

Handheld Program Preferences 
The ScanSeek RF handheld application allows you to customize the way your data 
collection application works through a set of program Preferences.  To change your 
program Preferences, tap File located on the lower left corner of your Record List 
screen.  Choose the Preferences option.  The “ScanSeek RF Preferences” dialog will 
appear. 
 

 
 
The following five options are available. 
 

• Don’t ask when adding new.  Choose this option to avoid having to confirm the 
addition of each new record. 

• Add new instead of copying.  If your Data Exchange has been configured to use 
the “All changes result in new records” option, each time you write or scan an 
existing search field value you will be taken to a detail view in which you may 
copy the existing record by tapping on the Copy button. Choose the Add new 
instead of copying option if you would prefer to create new blank records and 
proceed directly to the Edit view. 

• Hide ‘lookup’ Data Exchanges.  Choose this option to hide all lookup table Data 
Exchanges in the “Choose a Data Exchange” screen.  This option is often useful 
in applications that use a single data collection Data Exchange and multiple read-
only lookup table Data Exchanges. 

• Auto-Scroll when scanning.  For barcode-enable handheld devices, ScanSeek 
RF has been optimized to support multiple scan workflow.  When this option is 
chosen, ScanSeek RF will automatically set the current editing focus to the first 
empty text field in the application, indicated by a solid underline beneath the field 
value.  After each scan, ScanSeek RF will move the focus to the next empty field 
following the scanned field.  If no more empty fields exist, and the user has not 
manually edited any fields, ScanSeek RF will indicate completion of record 
editing with three short beeps.  Pressing the scan button a final time will indicate 
acceptance of the record, and ScanSeek RF will proceed as if the OK button had 
been pressed.  See the section titled “Working With a Barcode Scanner” for more 
information. 
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• Jump to Default Data Exchange.  If you specify a “default” Data Exchange in the 
Application Designer, selecting an Application will automatically take you to the 
default without having to go to the Select a Data Exchange screen.   

 
When you are finished customizing ScanSeek RF Preferences, tap the OK button.   
 

Note: Preferences are shared by all Data Exchanges in the application.  
Changes made to Preferences while working with one Data Exchange will 
continue to be used for all other Data Exchanges until they are again changed by 
the user. 

 

Working with a Barcode Scanner 
ScanSeek RF supports various barcode scanner enabled Windows CE devices.  
 
Barcode scanning features are automatically enabled whenever ScanSeek RF detects 
barcode scanner capabilities.  Scan features are enabled on the “Seek in” form and the 
Edit form of the application. 
 
From the Record List screen, scan a barcode associated with the search field to 
automatically view a matching record.  You do not need to tap the Action icon.  If the 
scanned barcode value does not match an existing search field, ScanSeek RF will 
assume you are adding a new record. 
 
From the Edit Record screen, the current scan focus field will have a solid (vs. gray or 
dotted) underline.  Scanning a barcode will automatically update the scan focus field to 
the scanned value.  If you have chosen the Auto-Scroll feature from the application 
Preferences, the focus will then move to the next empty text field in the application. 
 
If you have not tapped the screen with your stylus while editing the record, ScanSeek 
RF will beep three times after scanning the last scannable field, indicating completion.  
Pressing the scan button on the handheld one more time will send a Done message to 
the handheld, with the same effect as tapping the OK button.  The purpose of this 
feature is to support scanning applications that do not require looking at or tapping on 
the handheld screen during data collection.  In this mode, a user can scan a search field 
to add a new record, quickly scan collected data, and then press the scanner button a 
final time to save the record.  Tapping on the screen any time a record in Edit mode will 
cancel this functionality until a new record is edited. 
 
To scan a barcode into a field that does not have the scan focus,  tap on the field to 
bring up the popup text form.  Once the form is displayed, scan the barcode.  ScanSeek 
RF will automatically save the barcode data and close the popup text form. 
 

Note: ScanSeek RF has been designed so that every scan function can also be 
completed using the stylus on a non scan-enabled device. 
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Appendix A – Working with Microsoft Excel 
 

Creating an Excel Spreadsheet as a Data Source 
 
The following information is intended for example purposes only.   
 
An Excel spreadsheet can be used as a data source by creating a named range within 
the target spreadsheet. The named range can be used much like a database table 
through ODBC.  The following steps outline the creation of a simple spreadsheet with a 
named range.   
 
Launch Microsoft® Excel.  Begin with a new, empty worksheet. 
 
In cell A1, enter “Barcode.” In cell A2, enter “Description.” In cell A3 enter “Location.” 

 

 
 
To create the named range, use the mouse to select cells A1 through A3.  In the range 
box, type “example” followed by the Enter key. 
 



 50

Range

 
 

 
Select File>Save As.  Name the file and exit the application. 
 

Installing ScanSeek Analyzer for Microsoft® Excel 
Included with ScanSeek RF is an Add-In for Microsoft® Excel 2000 (or later) named 
“ScanSeek Analyzer.”  This tool verifies the contents of a named range within an Excel 
data file by searching for common errors. When configuring a Data Exchange to access 
a named range within an Excel spreadsheet, it is important that the spreadsheet is set 
up in a way that allows ScanSeek RF to treat it as a database table. The analyzer Add-
In should always be used to verify spreadsheet data prior to configuration as a 
ScanSeek Data Exchange. 
 
To install the Add-In, follow these steps: 
 
1. Launch Microsoft® Excel. 
2. Select Tools>Add-Ins… from the menu bar. 
3. Select the Browse… button. 
4. Navigate to the ScanSeek RF program directory (e.g. 

C:\ProgramFiles\RioScan\ScanSeek RF)  
5. Select the file ScanSeekAnalyzer.xla and click on the OK button. 
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Using ScanSeek Analyzer 
 
1. Create a named range in an Excel spreadsheet. 

 

 
 

2. Select Tools->ScanSeek Analyzer… from the menu bar. 
 
3. In the “ScanSeek Analyzer” dialog box, select the named range to validate from the 

drop down menu. Click on the Analyze button to continue. 
 

 
 
4. If problems are discovered concerning elements in the named range, the ScanSeek 

Analyzer will display one or more confirmation dialog boxes. Click on the Yes buttons 
for each of the dialog boxes if you would like the Analyzer to fix the problems 
encountered. 
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Example confirmation dialog boxes 

 
 

5. When the ScanSeek Analyzer has corrected all of the problems encountered, a 
dialog box will be displayed summarizing the Analyzer’s work. 

 

 
 
Click on the Done button when finished. Make sure to save your changes to the 
Excel spreadsheet when you are done using the ScanSeek Analyzer. 
 

 

 
Spreadsheet following modification by ScanSeek Analyzer
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Appendix B – The ScanSeek RF Server 
 
The ScanSeek RF Server allows the PC and the Pocket PC to communicate wirelessly.  
It must be installed and running in order for ScanSeek RF to work. 
 
There are two versions of the ScanSeek RF Server.  The file named 
“scanseekrfserver9x.exe” can be used by all versions of Windows.  The file named 
“scanseekrfserverNT.exe” can be used only by Windows NT, 2000, and XP. 
 

Note:  You must have a version of the RF server running in order to use 
ScanSeek RF. 

Installing and Using the 9x RF Server 
 
Locate the file “scanseekrfserver9x.exe” in your installation directory, usually  
C:\Program Files\RioScan\ScanSeek RF.   Double click on the file and the server will 
be activated.  It will be displayed on your Taskbar and initially maximized on your 
screen.  Click the minimize button to minimize it to your Taskbar.   
 
Once the RF server has been activated, you will know if it is running by looking on your 
Taskbar. 
 
To shut down the RF server, click the close button (X).   

Installing and Using the NT RF Server 
 
Locate the file “scanseekrfserverNT.exe” in your installation directory.  If you used the 
default directory that will be C:\Program Files\RioScan\ScanSeek RF.   
 
Go to a  DOS Command Prompt and change the current directory to the ScanSeek RF 
installation directory.  Type in the command:  scanseekrfserverNT –install.  There 
must be a space before the “-“.  You will get confirmation that the RF Server installed 
properly.  Close the Command Prompt window. 
 
Now that you have the RF Server installed, you must “start” the service. 
 
In Windows NT – go to Start>Settings>Control Panel>Services. Scroll down the list of 
services until you see ScanSeek RF.  Start the service by clicking on its name and then 
selecting the start button on the side of the screen.  Windows will display a “Service 
Control” window which will close after confirming that the service was started.  To 
confirm that the service has been started, check to see that the start button is disabled 
and the status of the service is listed as “Started”.  Whenever you want to change the 
status, you come here to do so. 

 
In Windows 2000 - go to Start>Settings>Control Panel>Administrative 
Tools>Services.  Scroll down the list of services until you see ScanSeek RF.  Start the 
service by clicking on its name and then selecting the start button at the top of the 
screen.  Windows will display a “Service Control” window which will close after 
confirming that the service was started.  To confirm that the service has been started, 
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check to see that the start button is disabled and the status of the service is listed as 
“Started”.  Whenever you want to change the status, you come here to do so. 

 
In Windows XP – go to Start>Administrative Tools>Component Services>Local 
Services.  Scroll down the list of services until you see ScanSeek RF.  The first time you 
use it, only “Start” will show to the left of the list.  Click “Start” to start the service.  
Windows will then display a “Starting” window which will close after confirming that the 
service was started.  At that time you will see “Pause” and “Stop” the service listed below 
“Start”.  Whenever you want to change your status, you come here to do so. .   
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Appendix C - Advisory/Warnings  
This section contains important information about various configuration and usage 
issues that can cause problems when working with ScanSeek RF. 

Changing Data Structures 
Once a ScanSeek RF Data Exchange has been configured, the system assumes that 
the original data structure for that Data Exchange will not change. If the number, type, or 
order of any data field changes, ScanSeek RF will have difficulty determining how to 
post changes made on the handheld.   
 
The proper way to change a data structure is as follows: 

 
1. Mark the Data Exchange you want to modify as Inactive by selecting 

Deactivate in the Application Designer.  
 
2. Make any desired changes to the original data source and, if necessary, 

update the previously defined ODBC System DSN to reflect those changes. 
 

3. In the ScanSeek RF Application Designer, either delete and recreate the 
Data Exchange for that data source or reconfigure the existing Data 
Exchange to produce the desired changes. 

 

Cross Lookup Loops 
When configuring Data Exchanges as lookup tables it is important to understand that 
Data Exchanges must not reference each other in a loop. That is, if Data Exchange A 
has been configured to use Data Exchange B as a lookup table, you cannot 
subsequently configure Data Exchange B to reference Data Exchange A as a lookup 
table.  

Re-installing the Handheld Software 
 
To install the software on additional devices, use Start>Programs>RioScan>ScanSeek 
RF>Install Handheld Apps.  Follow the on-screen instruction.
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Appendix D - Glossary of Terms 
 
Data Exchange–The virtual connection configured within the ScanSeek Data Exchange 
Wizard that refers to a specific ODBC DSN and establishes relationships associated with 
fields contained in the DSN and the ScanSeek RF application.   A Data Exchange is the 
combination of data and configuration information. 
 
Data Source–The source of information (data records), usually in the form of a database 
file or spreadsheet, referenced by an ODBC DSN. 
 
Data Source Name (DSN)–The name given to a configured ODBC data source. 
 
field–A single piece of data within a record.  In a spreadsheet, each cell will be a 
separate field. 
 
license code–A unique number generated by RioScan using a server serial number and 
ScanSeek product code. 
  
Open Database Connectivity (ODBC)–A standardized database access method 
developed by Microsoft Corporation. The method provides a way for applications to 
access data from other applications through the insertion of a middle layer known as a 
an ODBC driver. 
 
ODBC System DSN–An ODBC data source that has been configured for access by all 
users on a PC. 
 
ODBC User DSN–An ODBC data source that has been configured for access by a 
specific user on a PC. 
 
PC–Personal Computer. 
 
server serial number–A unique serial number generated by ScanSeek RF on as part of 
the server installation.   
 
unique identifier–A data field in a database table that contains a unique value. This 
value allows you to sort data. It may also be referred to as a unique key, a sort key, or 
an index. 
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Appendix E - Troubleshooting and Support  
 
Up to date troubleshooting and Frequently Asked Questions information is available on-
line at http://www.rioscan.com.  Please visit the site regularly for information on patches, 
upgrades, and other important information.  Contact your RioScan software reseller for 
information about obtaining an annual telephone support contract.  We are always 
available to answer questions via email.  Send your technical questions, feature 
requests, and other comments to support@rioscan.com. 
 

http://www.rioscan.com/
mailto:support@rioscan.com
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